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About ScanServer
ScanServer is a Microsoft Windows (95/98 & NT) application that acts as a DDE Server
and/or OPC (OLE for Process Control) to allow other Windows applications to access
measurement data from TempScan, MultiScan, NetScan and ChartScan instruments.
ScanServer supports all Windows DDE and OPC Client applications, including
Wonderware’s InTouch, Rockwell Software’s RSView, Microsoft’s Excel, and
Visual Basic.

Features
•   Supports RS-232/422, IEEE 488, and Ethernet 10BASE-T (TCP/IP)
•  Supports "Advanced DDE" and "Fast DDE" formats, standard XL Table, and

CF_TEXT.
•  Supports OPC Data Access Standard Release 1.0A.
•  Supports strings and numerics in single channel and multichannel arrays.
•  Provides DDE monitoring and diagnostic services.
•  Supports measurement rates up to ten times a second.
•  Supports unlimited modules over any number of communication ports.

System Requirements (Minimum)

•  IBM®-compatible 486.
•  Windows 95/98,or Windows NT 4.0.
•  8 MB (megabytes) of RAM (12 MB is recommended).
•  2 MB of hard disk space.
•  RS232/RS422, IEEE 488, or Ethernet 10BASE-T (TCP/IP)

Specifications
Maximum Nodes Unlimited.

Communication
Interface

RS232/RS422, IEEE 488, and Ethernet 10BASE-T (TCP/IP)

Poll Rates Foreground Polls: User-set from 0.1 to 100 s; default: 1 s.

Background Polls: User-set from 1 s to 1000 s; default: 10 s.

Time-outs: User-set from 2 sec to 10 s; default: 2 s.

Automatic Retries: User-set from 1 to 10; default:2.
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Getting Started
Reference Note:  To set up NetScan, TempScan, MultiScan or ChartScan
hardware, refer to the setup and installation sections of the corresponding user's
manual.

Reference Note:  A Net232 Ethernet/RS-232 Converter is required for TempScan,
MultiScan and ChartScan Ethernet Applications. The Net232 User’s Guide
(p/n 1037-0901) contains Ethernet-related information pertaining to these data
acquisition systems.

Installing ScanServer
The ScanServer disks include the ScanServer program files and a simple DDE Client
application useful in testing and troubleshooting DDE communications.  Complete the
following steps to install ScanServer on the computer hard drive:

Note:   The following steps are for installing from disks.  If your ScanSever program is on
a CD-ROM, simply install the CD-ROM and follow the installation screen
prompts.

1. Close all currently running Windows applications.

2. Insert ScanServer disk 1 in your floppy drive.

3. Choose Start/Run (or File/Run from Program Manager).

4. In the dialog box, type a:setup.exe   (b:setup.exe if installing from the b drive).

5. Choose OK and follow the on-screen instructions.

6. ScanServer will install to the directory you specify during installation.  The
default directory  is:

c:\Program Files\ScanServer

Quick Start
After you have installed ScanServer on your system, you must set up communication with
the TempScan, MultiScan, NetScan, or ChartScan instrument(s) attached to your system.
To do this, follow the procedures for:

1. Starting ScanServer.

2. Creating a node.

3. Configuring channels.

4. Saving the project.

5. Testing a node using the provided DDE Client.
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Starting ScanServer
From Windows 95/98 and Windows NT4.0, choose
Start/Programs/ScanServer/ScanServer.  The ScanServer Window will open.

ScanServer Window
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Creating a Node
1. From the ScanServer window, choose Node/New Node.  The New Node dialog

opens.

 
2. In the Node Name box, enter an alphanumeric string (e.g., TS1, a TempScan).

This string will be used for referencing the instrument in the DDE Connect
Topic box (discussed on page 10).

3. Set the Foreground (Sec) and Background (Sec) poll rates in the Poll Rate
box:

− Enter a value in the Foreground (Sec) box.  Valid Foreground Poll Rates
are 0.10 second through 10,000 seconds (in 0.10 second increments).  The
default Foreground Poll Rate is 1 second.

− Enter a value in the Background (Sec) box.  Valid Background Poll Rates
are 1 second through 10,000 seconds (in 1 second increments).  The default
Background Poll Rate is 10 seconds).

4. From the Interface box; select the appropriate radio button (Serial Port,
IEEE 488, or Ethernet).

5. Select the appropriate communications parameters in the Serial Port, IEEE 488,
or Ethernet box.

− For Serial Port (RS232/RS422) select the communication port where
ScanServer is connected (e.g., COM1).  Set the Baud Rate, Parity and
Handshaking configuration of the device.  Refer to your device user’s
manual as needed.
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− For IEEE 488, enter the bus address or IEEE 488 device name assigned to
the instrument.

− For Ethernet, enter the IP address or name.

Reference Note:  The communications settings must correspond to the instrument's
interface configuration.   Refer to the appropriate user’s manual(s), as needed.

Reference Note:  A Net232 Ethernet/RS-232 Converter is required for TempScan,
MultiScan and ChartScan Ethernet Applications. The Net232 User’s Guide
(p/n 1037-0901) contains Ethernet-related information pertaining to these data
acquisition systems.

6. Ensure the instrument is connected to the selected communications port and is
turned on.

7. Choose OK.
ScanServer now attempts to communicate with and identify an instrument using
the configuration settings for the New Node.

If communications and identification are successful, a “T” icon and text
(indicating the type of instrument found) are displayed in the project window.

In this screen shot, the created node (TS1) is displayed. ScanServer has detected a
device at COM2 and identified the device as a TempScan/1100.
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If communications or identification is not successful, a question mark (?) icon is
displayed; and an error is reported in the event window.  If this occurs, check that the
instrument is powered on and connected to the appropriate communications port.

In this screen shot, a new node could not be created.
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Configuring Channels
Using the configuration grid on the right side of the ScanServer window, select the
appropriate type channel type and enable the channels using the drop-down controls.
Configure only a few channels now.  More channels may be configured later.

Set the Node Online
From the ScanServer window, choose Node/Online to set the node in the online state.
The Online menu selection will be checked and the Online/Offline icon in the iconbar will
be displayed as depressed.
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Saving the Project
From the ScanServer window, choose File/Save Project.  A dialog box will open, waiting
for a filename to be entered.  The default name is ScanServer.  Enter a name and click the
Save button.

Testing the Node
We will use the DDE client supplied with ScanServer to test the node we have created.

1. From Windows 95, and with ScanServer running, choose
Start/Programs/ScanServer/DDE Client.  The DDE Client Window will open.
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2. Choose DDE/Connect. The DDE Connect dialog will open.

 
3. Type ScanServer in the Application box.

4. In the Topic box, type the name of the node (that you currently have configured
in ScanServer).

5. Click on Connect.  Information about the node will be displayed in the DDE
Client Window.

 

6. Choose DDE/Start Transaction.  The DDE Transaction dialog will open.

 
7. Enter last1 in the item box to select data from channel 1.
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8. Be sure CF_Text is displayed in the Format box.

9. Be sure Advise is selected in the Type box.

10. Click on Ok.  A transaction box will appear in the DDE Client window.  Data
from channel 1 of the attached ScanServer module should be displayed in the
box.
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✍  Notes
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Projects

Overview
Projects are mechanisms for saving and recalling a group of configured nodes; projects
are stored as .cfg files.  Nodes may be added to, deleted from, or modified within a
project.

Note: Only one project may be opened at a given time.

File Menu
Project options are available from the File menu.
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From the File menu,

•  Choose New Project… to open a new project window.

•  Choose Open Project… to open a previously saved project.

•  Choose Save Project to save changes to the open project since the last save.

•  Choose Save Project As… to save the open project with a new name.

•  Choose a project name from the list of recently open projects to open that
project.

•  Choose Exit to close the ScanServer application.

Starting a New Project
From the ScanServer window, choose File/New Project.  A fresh window is displayed
without any nodes.

Saving a Project
You may save an open project by choosing File/Save Project from the ScanServer file
menu.  Saving a project makes the current project the default project when ScanServer is
next started.

You can save an open project with a different name by choosing File/Save Project As…
from the ScanServer window.  The Save As dialog opens and allows you to name the
project and save it in a folder of your choice.

Saving a project with a different name allows you to create a new project with similar
node configurations.  After renaming a project, nodes and channel configurations within it
can be modified and saved as needed.
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Nodes

Overview
A ScanServer Node defines a NetScan, TempScan, MultiScan, or ChartScan instrument—
including its name, communication protocol, and foreground/background poll rates.

Node Menu
Node options are available from the Node menu.
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From the Node menu:

•  Choose Online to toggle all configured nodes between the online and offline
states.

Note:   ScanServer requires the nodes to be offline before allowing configuration of
nodes or channels.

•  Choose New Node… to open the New Node dialog from which you can enter
information for a new node.

•  Choose Edit Node… to open the Edit Node dialog from which you can change
information for the selected node.

•  Choose Delete Node… to delete the selected node from the open project.

Creating a Node
1. From the ScanServer window, choose Node/New Node.  The New Node dialog

opens.

 

2. In the Node Name box, enter an alphanumeric string (e.g., TS1, a TempScan).
This string will be used for referencing the instrument in the DDE Connect
Topic box (discussed on page 33).
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3. Set the Foreground (Sec) and Background (Sec) poll rates in the Poll Rate
box:

− Enter a value in the Foreground (Sec) box.  Valid foreground poll rates are
0.10 second through 10,000 seconds (in 0.10 second increments).  The
default Foreground Poll Rate is 1 second.

− Enter a value in the Background (Sec) box.  Valid Background Poll Rates
are 1 second through 10,000 seconds (in 1 second increments).  The default
Background Poll Rate is 10 seconds).

4. From the Interface box; select the appropriate radio button (Serial Port,
IEEE 488, or Ethernet).

5. Select the appropriate communications parameters in the Serial Port, IEEE 488,
or Ethernet box.

− For Serial Port (RS232/RS422) select the communication port where
ScanServer is connected (e.g., COM1).  Set the Baud Rate, Parity and
Handshaking configuration of the device.  Refer to your device user’s
manual as needed.

− For IEEE 488, enter the bus address or IEEE 488 device name assigned to
the instrument.

− For Ethernet, enter the IP address or name.

Reference Note:  The communications settings must correspond to the instrument's
interface configuration.   Refer to the appropriate user’s manual(s), as needed.

Reference Note:  A Net232 Ethernet/RS-232 Converter is required for TempScan,
MultiScan and ChartScan Ethernet Applications. The Net232 User’s Guide
(p/n 1037-0901) contains Ethernet-related information pertaining to these data
acquisition systems.

6. Ensure the instrument is connected to the selected communications port and is
turned on.

7. Choose OK.
ScanServer now attempts to communicate with and identify an instrument using
the configuration settings for the New Node.

If communications and identification are successful, a “T” icon and text
(indicating the type of instrument found) are displayed in the project window.
This is indicated in the figure on page 6.

If communications or identification is not successful, a question mark icon (?) is
displayed and an error is reported in the event window. This is indicated in the
figure on page 7.
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Editing a Node
To modify an existing node, first select it with a mouse click then choose the
Node/Edit Node menu selection.  The Edit Node dialog opens and allows changes to
be made.

Deleting a Node

Note:  The following method deletes the mode immediately.  There is no warning.

To delete a node:

1. Select the node to be deleted.

2. Choose the Node/Delete Node menu selection
(from the ScanServer window).

The selected node is deleted.
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Items

Item Types
ScanServer supports both strings and numeric data types for returning data.

Numeric items, indicated by a # preceding the item name, return a float or integer value
for the data item retrieved.  For example,

 #last1 returns:  23.752 to the client in a 4-byte floating-point variable,
if 23.752 degrees is read on channel 1.

String items, indicated by a $ preceding the item name, return data in formated ASCII
strings.  For example,

$last1 returns: 23.752 to the client as above but now in a 7-byte ASCII
string.

Note: Items not preceded with a # or $, default to numeric items.

Array data items return 2 or more String or Numeric data items.  Channels may be
indicated with commas separating them, with an inclusive dash between them, or with
both.  For example:

last1,3 returns two numeric data items, 23.752 and 24.567, assuming 23.752
degrees is read on channel 1 and 24.567 is read on
channel 3.

Another example:

$last1-3 returns three string data items, 23.752, 24.111 and 24.567.

In addition,

#last1-3,5 returns four numeric data items:  23.752, 24.111, 24.567and 25.333
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Item Names

Item Valid Formats Poll Rate Description

Lastx Numeric/String/Array Foreground Returns last stored data from channel(s) x.

x = 1 - 992

Outputx Numeric/String Foreground As a request: Returns the bit value the specified
digital output bit, x,  is currently set to.

As a poke: Sets the bit value of digital output bit x.

x = 1 - 32

Input Numeric/String Foreground Returns the value of the 8 bit input port.

Inputx Numeric/String Foreground Returns the bit value of the specified digital input
bit x.

x = 1 - 8

Time Numeric/String Foreground As a request: Returns the current time from the
device.

As a poke: Sets the device’s time; poke value
syntax: hh:mm:ss.

Date Numeric/String Background As a request: Returns the current date from the
device.

As a poke: Sets the device’s date; poke value
syntax: mm/dd/yyyy.

Status String Background Returns the device’s error status.  This string is
empty if no error exists.

Version String Background Returns the device Firmware version string

Note: Output, Input, Time, Date, and Version commands are not channel-dependent.
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Copy DDE Link

Overview
The DDE link copy feature allows you to copy information needed to create a DDE Link
to the Windows clipboard.  A DDE client that supports paste link can then use this
information to start a DDE conversation.  This feature simplifies many of the syntax
problems encountered in DDE Client applications.

Copying a DDE Link
The Copy DDE Link dialog is accessed from the Edit Menu.

1. From the ScanServer window, choose Edit/Copy DDE Link….
The Copy DDE Link to Clipboard dialog box opens.
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2. Enter a DDE command in the DDE Link String box, either by typing it in
manually or by selecting appropriate options from the other boxes in the dialog:

•  The Server name is ScanServer and cannot be modified.

•  Choose a node from the pull-down list of available nodes in the Node Name
box.

•  Choose an item from the pull-down list of available items in the Item Name
box.

•  For channel specific commands, select the channel(s) for the command.

◊ Channels are selected/deselected by clicking on them.

◊ Consecutive channels are selected by selecting one channel, then
pressing SHIFT and the first or last channel in the sequence.

◊ An unordered sequence of channels is selected by pressing CTRL and
clicking on each channel in the sequence.

•  If applicable, select either Text or Numeric as the Data Format for the
command.

3. Choose OK to copy the displayed DDE Link String to the clipboard.
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Options

View Menu
From the View menu, you can select whether to display the Toolbar and the Status Bar.

From the View menu,

•  Select/deselect Toolbar.
◊ When checked, the Toolbar is displayed under the Menu bar in the

ScanServer window.
◊ When not checked, the Toolbar is not displayed.

•  Select/deselect Status Bar.
◊ When checked, the Status Bar is displayed at the bottom of the ScanServer

window.
◊ When not checked, the Status Bar is not displayed.
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✍   Notes   
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Using Microsoft Excel with ScanServer

Procedures
1. Start Microsoft Excel.

Note: In Excel, DDE information must be entered in the following format:
=application|topicname!item

2. Enter the following in any empty cell:
=ScanServer|ts1!last1

where ts1 is the node name you entered when you created the node.

3. Press ENTER.  Data from channel 1 should be displayed as an alphanumeric
string in the cell.

 

4. Now create an array by selecting six adjacent cells in any column.

 Note: In Excel, arrays of DDE information must be entered by selecting the same
number of cells as channels to be read, entering =application|topicname!’item’,
and then pressing CTRL-SHIFT_ENTER to execute the command.

5. Type the following :
=ScanServer|ts1!’last1-4’
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6. Press CTRL-SHIFT-ENTER.  Numeric data from channels one through six
should be displayed in the selected cells.

Tips
In Excel, DDE information must be entered in the following format:
=application|topicname!’item’

Press CTRL-SHIFT-ENTER to execute an array command.

The ScanServer Copy DDE Link command simplifies formatting DDE commands in
Excel.  We strongly recommend that you use this feature when working with Excel.
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Using RSView32 6.0 with
ScanServer and OPC

Procedures
1. Start RSView32 Works.

2. From an open project, create a Node using the System Node editor, to access the
ScanServer device.
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The OPC browser may be used from within the RSView32 Node Editor to easily
select ScanServer from a list of the installed OPC servers.
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3. Create tags to access ScanServer data via the RSView32 System Tag Database
Editor.  The tag address uses the ScanServer node name enclosed in square
brackets followed by the item name.
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4. Test the tags using the RSView32 System Tag Monitor.
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5. Create a graphic that uses the tags.

Tips
RSView32 can uses both the DDE and OPC services of ScanServer, however the OPC
services are preferred because of better performance and future compatibility.

To allow RSView32 to automatically start ScanServer, its location must be added to the
“Path” environment variable.
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✍   Notes
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Using DDE Client with ScanServer

Introduction
The DDE Client application is provided as a quick and convenient way of verifying that
ScanServer software is configured properly; and that the data acquisition devices are
connected correctly to your system.

Note:  DDE Client is for configuration verification only.  It is not a data collection or data
analysis application.

Procedures

Start DDE Client

 

 Start the DDE client application from the “Start” menu.

Connect to ScanServer and a Topic

 

 Connect the DDE client to the ScanServer via the Connect item in the DDE menu.

 Note:  The ScanServer “Node” name is used for the DDE “Topic” name.
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Start a Transaction

 

 DDE transactions are started via the Start Transaction item in the DDE menu.
Several types of transactions are supported.  The “Advise” type is commonly used to
establish a “Hot Link” with the ScanServer.  Alternately the “Request” type may be
used to establish a “Warn Link” with the server.

 Note:  ScanServer does not support Execute type transactions.

Poke a Value

 

 The DDE client supports sending data to the ScanServer via the Poke type
transaction.  Using this type of transaction, a user may set an output bit on an
instrument.
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 When a Poke transaction is selected, the DDE client then asks for the data to be sent
to the selected item, in this case a “1” is sent to output bit 1.

 

 

Abandon a transaction

 Abandon transaction is used to terminate a previously established “Advise” or
“Hot Link” transaction.
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 ✍     Notes
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Glossary
AdvanceDDE Rockwell Software’s highly optimized DDE format; capable of

transferring multiple data items efficiently in a single DDE message.

Advise A DDE service that receives the specified data item from the module
continually as it changes.

Background Poll
Rate

The rate at which ScanServer queries the module for static data (e.g., unit
ID).

CF_Text A standard DDE format for transferring data between a DDE Server and a
DDE Client; designed to transfer a single ASCII text string in a DDE
message.

Communication
Protocol

Mechanism or network that ScanServer uses to communicate with the
ScanServer instruments (RS232/RS422 or RS485).

DDE Client A Windows application that requests services from a DDE Server.

DDE Server A Windows application that provides data services to a DDE Client.

DDE Dynamic Data Exchange; Microsoft’s standard inter-process
communication protocol; a mechanism for transferring data between
applications.

FastDDE WonderWare’s highly optimized DDE format; capable of transferring
multiple data items efficiently in a single DDE message.

Foreground Poll
Rate

The rate at which ScanServer queries the module for constantly changing
data (e.g., meas1).

Item Defines the specific data sent to or received from a DDE topic through the
DDE Server (e.g., time or meas1)

Poke A DDE service that sends data to the module through the DDE Server.

Project A mechanism for saving and recalling a group of configured nodes; stored
as a .cfg file.

Request A DDE service that receives the specified data item from the module
through the DDE Server.

Node Defines a ScanServer instrument, including its name, communication
protocol, and foreground and background poll rates.

XL_Table An optimized DDE format for transferring multiple cells of data between a
DDE Server and Microsoft’s Excel in a single DDE message.
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✍     Notes
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